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ASSIGNMENT- 1 
  
 
Q1: WHAT ARE THE FOUR FUNDAMENTAL PARTS OF 
COMPUTER? EXPLAIN IT WITH THE HELP OF DIAGRAM. 
ANS: A computer has four main components: the central processing 
unit or CPU, the primary memory, input units and output units. A 
system bus connects all four components, passing and relaying 
information among them. This type of computer organization and 
architecture is called a "von Neumann machine" after John von 
Neumann, who finalized the theory and design of the first modern 
digital computer. 
 
CPU 
Computer scientists typically call the CPU the "brain" of the 
computer because this is where programs are executed. A 
program is a set of instructions that tells the computer how to 
accomplish a specific task, such as sending a file to the printer, 
opening a browser window, or playing music or video. 
The CPU is further broken up into three smaller components: the 
arithmetic unit handles all the simple mathematical computations; the 
control units interpret the instructions in a computer program; and the 
instruction decoding unit converts computer programming instructions 
into machine code. Machine code is the basic language understood by all 
the components in a computer. 
 
 
 



 

Memory 
 
Once the CPU converts a specific set of computer program instructions into 
machine code, it stores that machine code in primary storage or memory. 
The machine code will be treated as either data or instructions. The CPU 
fetches data and instructions from memory, uses an instruction to manipulate 
the data, and then sends the result and the next set of instructions back to 
memory. 
 
Input Units 
 
Input units are all the devices you use to feed information to the computer, 
such as a keyboard, a hard drive or a networking card. These devices, in 
essence, bring data from the "outside world" into your computer, in much 
the same way that your eyes and ears bring information to your brain. Each 
input device has its own hardware controller that connects to the CPU and 
primary memory, and it has a set of instructions that tells the CPU how to use 
it. 
Output Units 
 
Output units are the devices your computer uses to relay information to the 
user, such as a printer, monitors and speakers. For example, everything you 
see on your computer monitor starts as machine code in memory. The CPU 
takes that machine code and converts it into a format required by your 
monitor's hardware. Your monitor's hardware then converts that information 
into different light intensities so that you see words or pictures 
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Q2: discuss about the classification of computer based on 
size and capacity? 
Ans-Based on size and capability, computers are broadly classified into 
a.   Microcomputers(Personal Computer) 
A microcomputer is the smallest general purpose processing system. The 
older pc started 8 bit processor with speed of 3.7MB and current pc 64 bit 
processor with speed of 4.66 GB. 
Examples: - IBM PCs, APPLE computers 
Microcomputer can be classified into 2 types : 
1. Desktops 
2. Portables 
The difference is portables can be used while travelling whereas 
desktops computers cannot be carried around. 
The different portable computers are: - 
1) Laptop 
2) Notebooks 
3) Palmtop (hand held) 
4) Wearable computers 
Laptop: - this computer is similar to a desktop computers but the size is 
smaller. They are expensive than desktop. The weight of laptop is around 3 
to 5 kg. 
 
Notebook: - These computers are as powerful as desktop but size of 
these computers are comparatively smaller than laptop and desktop. 
They weigh 2 to 3 kg. They are more costly than laptop. 



 

Palmtop (Hand held): - They are also called as personal Digital Assistant 
(PDA). These computers are small in size. They can be held in hands. It is 
capable of doing word processing, spreadsheets and hand writing 
recognition, game playing, faxing and paging. These computers are not as 
powerful as desktop computers. Ex: - 3com palmV. 
 
 Wearable computer: - The size of this computer is very small so that it can 
be worn on the body. It has smaller processing power. It is used in the field 
of medicine. For example pace maker to correct the heart beats. Insulin 
meter to find the levels of insulin in the blood. 
 
c) Mainframe computers: - Computers with large storage 
capacities and very high speed of processing (compared to mini- or 
microcomputers) are known as mainframe computers. They support a large 
number of terminals for simultaneous use by a number of users like ATM 
transactions. They are also used as central host computers in distributed data 
processing system. 
Examples: - IBM 370, S/390. 
 
 
d) Supercomputer: - Supercomputers have extremely large 
storage capacity and computing speeds which are many times faster than 
other computers. A supercomputer is measured in terms of tens of millions 
Instructions per second (mips), an operation is made up of numerous 
instructions. The supercomputer is mainly used for large scale numerical 
problems in scientific and engineering disciplines such as Weather 
analysis. 
Examples: - IBM Deep Blue 
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Q3: what is the meaning of computer generation? How many
computer generations are
used? 
Ans: Following is a brief summary
on their hardware and software
 
 

In the late 1940s and early 1950s
vacuum tubes for their digital logic and liquid 
storage. 
 
 

In the late 1950s, transistors replaced tubes and used magnetic cores for
memories (IBM 1401, Honeywell
significantly improved 
 

In the mid-1960s, computers
CDC 6400) and the first operating systems and database management
systems. Although most processing was still batch oriented using punch
cards and magnetic tapes, online systems were being 
the era of mainframes and minicomputers, essentially large
computers and small departmental
 

the mid to late-1970s spawned the microprocessor and personal
computer, introducing distributed
 
 
  

Q3: what is the meaning of computer generation? How many
are defined? What technologies were

summary of the generations of computers
hardware and software architecture.. 

1950s (EDSAC, UNIVAC I, etc.) computers
vacuum tubes for their digital logic and liquid mercury memories

In the late 1950s, transistors replaced tubes and used magnetic cores for
Honeywell 800). Size was reduced and reliability

computers used the first integrated circuits (IBM
CDC 6400) and the first operating systems and database management
systems. Although most processing was still batch oriented using punch
cards and magnetic tapes, online systems were being developed. This
the era of mainframes and minicomputers, essentially large centralized

departmental computers. See 

1970s spawned the microprocessor and personal 
distributed processing and office automation.

Q3: what is the meaning of computer generation? How many 
were / are 

computers based 

computers used 
mercury memories for 

In the late 1950s, transistors replaced tubes and used magnetic cores for 
reliability was 

(IBM 360, 
CDC 6400) and the first operating systems and database management 
systems. Although most processing was still batch oriented using punch 

developed. This was 
centralized 

 
automation. 



 

Fifth Generation - The Future 

Word processing, query languages, report writers and spreadsheets put large 
numbers of people in touch with the computer for the first time. 
 

the 21st century ushered in the fifth generation, which increasingly delivers 
various forms of artificial intelligence (AI). More sophisticated search and 
natural language recognition are features that users recognize, but software 
that improves its functionality by learning on its own will change just about 
everything in the tech world in the future. 
TECHNOLOGIES WERE/ARE USED 
 Communications technologies. ... 
 Office productivity. ... 
 Record keeping and retrieval. ... 
 Internet and search. ... 
 Analytics and new decision structures. ... 
 Automation, robotics and future factories. ... 
 Adoption of virtual and augmented reality. 
 Conversational systems 
 Information security 
 
Q4.Differentiate between volatile & non- volatile 
memories. 
What is Volatile Memory?  
Volatile Memory is the kind of computer memory that stores data temporarily. It 
is also referred as temporary memory. The data in the volatile memory is stored 
only until the power is supplied to the system, once the system is turned off the 
data present inside the volatile memory is deleted automatically. RAM and cache 
of the computer system are the best common example of the volatile memory. 
Volatile memory due to its temporary nature its stores only the frequently used 



 

data. The data of the programs running on
memory. It is quite fast and efficient in
Volatile memory is directly linked to the
The more amount of volatile memory
computer system will possess. Common
RAM, Cache, etc. 
What is Non-volatile 
Non-volatile Memory is the kind of computer memory that stores the data
permanently. The data stored in the non
the system is turned off. ROM of the computer is the non
not that much efficient and fast in nature as compare to volatile
stores data for the longer period. Non
information inside it such as the boot process information,
information and BIOS. Non-volatile memory is slow
such data that needs to be stored
non-volatile memory. Non-volatile memory has a
storage capability. The more non
space will be there. Common examples
drive, optical discs, flash memory,
Volatile Memory vs. Non
 Volatile Memory is
system.
 Non-volatile Memory
system.
 Data of programs in
in volatile memory.
 System’s information,
in non-volatile memory.
 Volatile memory is
 Non-volatile memory  
Q5: Distinguish among system
source software on the basis of

the programs running on the processor is stored in volatile 
memory. It is quite fast and efficient in nature and can be accessed rapidly. 
Volatile memory is directly linked to the performance of the computer system. 
The more amount of volatile memory the more effective performance the 
computer system will possess. Common examples of the volatile memory include

 Memory? 
volatile Memory is the kind of computer memory that stores the data

in the non-volatile memory remains there even
the system is turned off. ROM of the computer is the non-volatile memory. It is 
not that much efficient and fast in nature as compare to volatile memory but 
stores data for the longer period. Non-volatile memory possesses the basic system 
information inside it such as the boot process information, system starting up 

volatile memory is slow regarding accessing.
stored permanently or for a longer period is stored in 
volatile memory has a direct impact on the system’s 

storage capability. The more non-volatile memory, the more permanent storage 
space will be there. Common examples of non-volatile memory include

memory, etc. 
Non-Volatile Memory 

is the temporary memory of the computer
Memory is the permanent memory of the

in the process and frequently used data
information, BIOS and all the other kind of data

is fast and efficient in nature.
memory is slow and permanent in nature.

system software, application software and
basis of their features. 

the processor is stored in volatile 
nature and can be accessed rapidly. 

performance of the computer system. 
more effective performance the 

memory include 

volatile Memory is the kind of computer memory that stores the data 
volatile memory remains there even after 

memory. It is 
memory but 

the basic system 
system starting up 

accessing. All 
period is stored in 

direct impact on the system’s 
memory, the more permanent storage 

include a hard 

computer 
 computer 

data is stored 
data is stored 

nature.

and open 



 

Ans: Difference between system software and application software 
source software 
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System Software. Application Software. 

 
 
1

Definiti
on 

System Software is the 
type of software which is 
the interface between 
application software and 
system. 

On other hand Application 
Software is the type of 
software which runs as per 
user request. It runs on the 
platform which is provide 
by system software. 

  
2

Develo
pment 
Langu
age 

In general System software 
are developed in low level 
language which is more 
compatible with the system 
hardware in order to interact 
with. 

While in case of Application
software high level 
language is used for their 
development as the are 
developed as some 
specific purpose software. 

    

 
3

Usage System software is 
used for operating 
computer hardware. 

On other hand 
Application software 
is used by user to 
perform specific 
task.  

4
Installat
ion 

System software are 
installed on the computer 
when operating system is 
installed. 

On other hand Application 
software are installed 
according t user’s 
requirements. 

  
5

Use
r 
inter
acti
on 

As mentioned in above points 
system software are specific 
to system hardware so less 
or no user interaction 
available in case of system 
software. 

On other hand in 
application software user 
can interacts with it as user 
interface is available in th 
case. 



 

 
 6

Depen
dency 

System software can run 
independently. It provides 
platform for running 
application software. 

On other hand in 
application software can’t 
run independently. They 
can’t run without the 
presence of system 
software.. 

 
 7

Exampl
es 

Some examples of system 
software’s are compiler, 
assembler, debugger, driver, 
etc. 

On other hand some 
examples of application 
software’s are word 
processor, web browser, 
media player, etc. 

 

Open Sources 
What is open source software? 
 Open source software is software with source code that anyone can 
inspect, modify, and enhance."Source code" is the part of software 
that most computer users don't ever see; it's the code computer 
programmers can manipulate to change how a piece of software—
a "program" or "application"—works. Programmers who have 
access to a computer program's source code can improve that 
program by adding features to it or fixing parts that don't always 
work correctly. 
What's the difference between open source software and 
other types of software? 
 Some software has source code that only the person, team, or 
organization that created it—and maintains exclusive control 
over it—can modify. People call this kind of software 
"proprietary" or "closed source" software. 
 Only the original authors of proprietary software can legally copy, 
inspect, and alter that software. And in order to use proprietary 
software, computer users must agree (usually by signing a license  
 



 

displayed the first time they run this software) that they will not do 
anything with the software that the software's authors have not 
expressly permitted. Microsoft Office and Adobe Photoshop are 
examples of proprietary software. 
Q6: (a) create a file in Ms Word to insert a paragraph about 
yourself and save it with file name ‘’yourself”. 
Describe all steps involved in it. 
Ans: we have some steps of ms word. 
 Firstly we go to the Ms Word.
 Then we type our text in Ms Word.
 After type the text we go to the office button.
 Then click on save option.
 After that we give file name “yourself”.
 Then we select save as type word document.
 Then click on ok.
Q6 (b): write steps regarding followings. 
 To change the font style.
 To change the font size.
 To change the font color.
 To highlight (in yellow) the line that reads “need to get 



 

IMS’s address”
 Ans : to change the font style-
 Firstly we select the given text.
 Then we go to the home tab.After that we go to the font group.
 Then we go to the font style and we will saw different 
type of font style.
 After that we click on any one font style.
 To change the font size.
 Firstly we select the given text.
 Then we go to the home tab.
 After that we go to the font group.
 Then we select font size as you want.
 To change the font color.
 Firstly we select the given text.
 Then we go to the home tab.
 After that we go to the font group.
 Then we select font colure as you want then click on 
the colure.



 

  To highlight (in yellow) the line that reads “need to
get IMS’s address” 

firstly we select the given
 then click on home
 Then we click on text
 After that we choose
Q7. Create a file in Ms
and save it with file name ‘Ms
involved in it. 
Ms-Word is widely used commercial 
Word is application software which is capable of
 Creating  
 Editing  
 Saving  
 Printing any type of document Ans: steps 
1. Type the given text “
developed by Microsoft.” Then press enter key
 
2. Type “Ms-word is application software which is capable of” 
key 
 
3. After that select “bullet”
 

To highlight (in yellow) the line that reads “need to

the given text “ need to get IMS’s address”
home tab

Then we click on text highlight color on font
choose yellow color.

Q7. Create a file in Ms-Word for the following document
and save it with file name ‘Ms-Word’ describe all steps

 word processor developed by Microsoft. Ms-
which is capable of 

document 

Type the given text “Ms-Word is widely used commercial word processor
press enter key 

word is application software which is capable of” then press enter

select “bullet” from “bulleted list” from “home

To highlight (in yellow) the line that reads “need to 

address”

font group.

Word for the following document 
Word’ describe all steps 

word processor 

then press enter 

“home tab”. 



 

4. Then type “creating” and press “enter key”. Then type 
“Editing” and press “enter key”. After that type “saving and press 
enter key”. Then we type “printing any type of document” and press 
“enter key”. 
 
5.    2  
6. Then we select word processor then we go to the home tab after that 
we go to font group and we click on underline. 
 
7. After that we select the creating text and go to home tab and click 
on font color and select sky blue color. 
 
8. Then we select saving text and go to the home tab and click on font 
color and select red color. 
 
9. After that we select “printing any type of document” text and go to 
the home tab and then go to the font group and click on bold option 
 Q8: create a file in Ms-Word for the following document and save 
it with file name ‘ms-word’. Describe all steps involved in it. 
 
Equations X2 + 
Y5= 30 

Z3 +Q4= 50 
 
A2 + B8= X2 + Y8 



 

Ans: we have some steps which we follow. 
 Firstly we open the Ms-Word and write the 
equations.
 Next we type X then we go to font group and click on subscript then press 2 after that we press
+ button from keyboard. Then we type Y then we do 
subscript and press 5 from the keyboard. Then we 
press = button from keyboard. Then type 30 
 For the second equations we type Z and again do 
subscript from the font group. Then we type 3. After 
that we type Q then we click on superscript from the 
font group. And press 4. After that we pres on = button 
then we type 50
 For the third equations we type A then we click 
on subscript. And type 2. After that we press + button 
from keyboard. Then we type B and do superscript 
from font group. Then we type 8. After that we press = 
button. Then we type X and again we do subscript. And 
press 2. Then we press on + button. After that we type 
Y. then we do superscript. And type 8.



 

 After that we go to the office button. And click 
on save. After that we have give the file name 
‘equations’ then click on save option.
Q9. Create a file in Ms-word that convert existing 
highlight text to table as shown below and save it as 
file name ‘text_to_table’ describe all steps involved it. 
Select the text you want to convert 
Select the insert tab. 
Click on table command. A dialog box appears. 
Click on convert text to table, a new dialog box 
appears 
Here set number of columns. 
Click on OK finally selected text convert in a table. 
 
 
 Select the text you want to convert. Select the insert tab. 
  
 
Click on table command. A dialog box 
appears. 

Click on convert text to table, a new dialog box appears. 
    
 
Here set number of columns. Click on ok finally selected text convert in a table. 



 

Ans. We have followed some steps. 
 Firstly we select the text. 
 Then go to insert tab. 
 Then we go to the table option. 
 After that we selected text to table option. 
 Then we select on separate text according to 
paragraph. 
 After that we click on ok. 
 Then finally we go to the office button. The click 
on save option then we write the file name 
‘text_to_table’ and click on ok. 
Q10. Create a file in Ms-word to insert a table in the 
document. Describe all steps involved in it. 
Ans: we follow some steps here. 
 Firstly we go to the Ms-word. 
 Then we go to the insert tab. 



 

 After that we click on table. 
 And go to insert table option. 
 Then we select the rows number according you 
wants. And then you select column numbers. And 
click on ok. 
 After that you will saw a table on you display. 
Q11. Create a following worksheet in Ms-excel and 
save it with name ‘book’1’ 
 



 

Ans: we have followed some steps. 
 Firstly we go to Ms-excel. And open a sheet 
 Then we type Roll no on a column. 
 After that we type Roll no laneways upward to 
downwards. 
 Then we go to b column and we type name. 
After that we type all the name upward to 
downward. 
  After that we go to c column and type marks. 
Then we type All marks upward to downward. 
 At last we go to office button and go to save 
option and give the file name ‘book’1’and click on ok. 
Q12. Calculate the following things of a range ( c2:c11) 
of data in the worksheet created in question no 10. 
  The sum of the marks using Auto sum in 
a range of cells (c2:c11) 
 Average of the marks in a range of cells (c2:c11) 



 

 Highest marks in a range of cells (c2:c11) 
 Minimum marks in a range of cells (c2:c11) 
Ans: we have followed some steps here. 
 For sum firstly we go to the insert function. 
Then we type =SUM (c2:c11) and then press enter. 
 For average firstly we go to the insert function. 
Then we type =AVERAGE (c2:c11) and then press enter. 
 For highest mark firstly we go to the insert function. Then we type =MAX (c2:c11) and then press enter. 
 For minimum mark firstly we go to the insert 
function. Then we type =MIN (c2:c11) then we press. 
Q13. (a) Describe various steps involved in the 
following. 
 To modify column width of a worksheet. 
 To modify the row height of a worksheet. 



 

 To delete rows and columns of a worksheet. 
Q13. (b) Describe following terms in the worksheet. 
 Absolute reference and relative reference in 
formula 
 Cell address  
Ans. (a) 1. Set a column to a specific width. 

1. Select the column or columns that you want to 
change. 

2. On the Home tab, in the Cells group, click Format. 
3. Under Cell Size, click Column Width. 
4. In the Column width box, type the value that you want. 
5. Click OK. 
2. To modify the row height of a worksheet. 
1. Click the Format command on the Home tab. The format drop- 
down menu appears. 
2. Select the rows you want to modify. 
3. Select Row Height. Increasing the column width. 
4. The Row Height dialog box appears. Enter a specific 
measurement. ... 
5. Click OK. 



 

3. if you don't need any of the existing cells, rows or 
columns, here's how to delete them: 
1. Select the cells, rows, or columns that you want to delete. 
2. On the Home tab, click the arrow under Delete, and then click the appropriate delete option. 
 
Ans.13 (b) Absolute reference and relative reference 
in formula 
Relative references 
By default, all cell references are relative references. When 
copied across multiple cells, they change based on the relative 
position of rows and columns. For example, if you copy the 
formula =A1+B1 from row 1 to row 2, the formula will become 
=A2+B2. Relative references are especially convenient whenever 
you need to repeat the same calculation across multiple rows or 
columns. 
 
To create and copy a formula using relative references: 
In the following example, we want to create a formula that will 
multiply each item's price by the quantity. Rather than create a 
new formula for each row, we can create a single formula in cell 
D2 and then copy it to the other rows. We'll use relative references 
so the formula correctly calculates the total for each item. 



 

1. Row_num (required argument) – This is a numeric value 
specifying the row number to be used in the cell reference. 

2. Column_num (required argument) – A numeric value 
specifying the column number to be used in the cell 
reference. 

3. Abs_num (optional argument) – This is a numeric value 
specifying the type of reference to return: 

 Cell address
The cell ADDRESS function is categorized under Excel Lookup and 
Reference functions. It will provide a cell reference (its “address”) 
by taking the row number and column letter. The cell reference will 
be provided as a string of text. The function can return an address in 
a relative or absolute format and can be used to construct a cell 
reference inside a formula. 
As a financial analyst, cell ADDRESS can be used to convert a 
column number to a letter, or vice versa. We can use the function 
to address the first cell or last cell in a range.  
 
Formula 
=ADDRESS (row_num, column_num, [abs_num], [a1], 
[sheet text])  
 
The formula uses the following arguments: 
 



 

Q14. (a) What tools 
PowerPoint presentation?
 
Ans (a) 1. Visme 
Visme is a cloud-based presentation tool that allows you to
highly visual presentations to engage viewers and
your ideas. It features an intuitive, drag
for creating presentations. The business version
brand consistency and company
your employees create a presentation, it
and images that are on brand for your
consistency across presentations
also offers a built-in analytics
viewed your presentation and
Visme offers multiple plans ranging from $20 per user per
to $60 per three users per month. It's also
demo to see how the technology
 
2. Haiku Deck 
Haiku Deck is a platform that prioritizes simplicity. Business
owners can create elegant, basic presentations with high
images. The Spartan approach allows for connecting with
audiences instead of losing them in information overload due to
text-heavy slides. What separates Haiku Deck from traditional
presentation tools is its library
makes it easy to craft simple,
accessible on any device.
Haiku Deck offers three plans, ranging
month. 
 

 are available to customize
presentation? 

based presentation tool that allows you to
visual presentations to engage viewers and communicate 

your ideas. It features an intuitive, drag-and-drop design method 
for creating presentations. The business version also prioritizes 
brand consistency and company-wide image storage. When you or 

ployees create a presentation, it will feature colors, logos 
and images that are on brand for your organization. This promotes 
consistency across presentations among your employees. Visme 

in analytics system, so you can see who has 
ed your presentation and who finished it. 

Visme offers multiple plans ranging from $20 per user per
per month. It's also possible to get 

how the technology works before you try it out.

is a platform that prioritizes simplicity. Business
owners can create elegant, basic presentations with high-
images. The Spartan approach allows for connecting with
audiences instead of losing them in information overload due to

vy slides. What separates Haiku Deck from traditional
library of images and array of fonts.

simple, powerful presentations that
any device. 

plans, ranging from $7.99 to $29.99

to customize our 

based presentation tool that allows you to create 
communicate 

design method 
also prioritizes 

storage. When you or 
will feature colors, logos 

organization. This promotes 
among your employees. Visme 

system, so you can see who has 

Visme offers multiple plans ranging from $20 per user per month 
 a free live 

it out. 

is a platform that prioritizes simplicity. Business 
-quality 

images. The Spartan approach allows for connecting with 
audiences instead of losing them in information overload due to 

vy slides. What separates Haiku Deck from traditional 
fonts. It 

that are 

$29.99 per 



 

3. Pitcherific 
Pitcherific is not only a presentation solution, but also a platform
building and practicing your presentation. It's a template
program that guides you through the presentation creation
Instead of drafting a few slides, Pitcherific prompts you
the areas of each part of your speech. The outline for
pitch, for example, includes a hook, problem,
There are various templates for different
presentations, so you'll have guidance on
and presentations. Pitcherific also
each section and a timeclock,
speech or presentation is 
Pitcherific's pricing depends largely on your business and its
needs, so you'll have to reach
quote. Pitcherific does offer a free trial in case you're curious to
how the platform works. 
 
4. Canva 
Canva is an online platform that provides templates for a wide
range of business-related publications,
business cards, media kits, brochures and info graphics. You can
also use it to construct presentations. There
design layouts and templates to start with, and you can upload
own images or choose from more than 1 million of
images. As you build your
fonts, add filters to images, and drag and drop
for design. You can also upload and save
Canva offers a free version equipped with all its features. If
a startup or very small business owner, this is a good
larger businesses, Canva for Work offers team

is not only a presentation solution, but also a platform
building and practicing your presentation. It's a template-
program that guides you through the presentation creation

drafting a few slides, Pitcherific prompts you to write out 
the areas of each part of your speech. The outline for an elevator 
pitch, for example, includes a hook, problem, solution and closing. 
There are various templates for different kinds of pitches 
presentations, so you'll have guidance on many kinds of speeches 
and presentations. Pitcherific also recommends a character count for 
each section and a timeclock, allowing you to track how long your 

 and stay within a desired range.
Pitcherific's pricing depends largely on your business and its

have to reach out to its sales team to get a
quote. Pitcherific does offer a free trial in case you're curious to

 

nline platform that provides templates for a wide
related publications, like resumes, newsletters,

business cards, media kits, brochures and info graphics. You can
presentations. There are hundreds

layouts and templates to start with, and you can upload
own images or choose from more than 1 million of Canvas’s

your presentation, you can adjust text and 
fonts, add filters to images, and drag and drop different elements 
for design. You can also upload and save your company 
Canva offers a free version equipped with all its features. If
a startup or very small business owner, this is a good option. For 
larger businesses, Canva for Work offers team management 

is not only a presentation solution, but also a platform for 
- based 

program that guides you through the presentation creation process. 
to write out 

an elevator 
solution and closing. 

kinds of pitches and 
many kinds of speeches 

recommends a character count for 
allowing you to track how long your 

range. 
Pitcherific's pricing depends largely on your business and its 

get a direct 
quote. Pitcherific does offer a free trial in case you're curious to see 

nline platform that provides templates for a wide 
newsletters, 

business cards, media kits, brochures and info graphics. You can 
are hundreds of 

layouts and templates to start with, and you can upload your 
Canvas’s stock 

adjust text and 
different elements 

 logo. 
Canva offers a free version equipped with all its features. If you're 

option. For 
management 



 

features for $12.95 per month (or $9.95 per month
annually). You can try this version free for 30
 
5. Slide Camp 
Slide Camp provides slide templates for creating company
presentations. You can adjust color schemes, add company
import charts and data, build info graphics, and organize
presentations into sections with Slide Camp. This is a great
solution for maintaining presentation consistency across
presentations from your organization. After you set up
details, employees will be able to work with
easily craft professional presentations. It's
businesses, so if you're a startup or one
not be an ideal solution for
There are a few plans available, 
month depending on the number of users who will access
Camp. There is a demo version
service to see if it's right 
6. Microsoft Events 
While PowerPoint may be a tired 
presentation at times, Microsoft
new level of practicality to the standard presentation.
introduced the ability to create live and on
Microsoft 365. These events
demand by remote co-workers or even workers who were
the meeting but want to reference what was said. It
video with machine learning to create a speaker
text transcriptions and time c
Live events are part of the Office
you're already a subscriber, you can use this tool for no

features for $12.95 per month (or $9.95 per month when you pay 
annually). You can try this version free for 30 days. 

provides slide templates for creating company
presentations. You can adjust color schemes, add company

charts and data, build info graphics, and organize 
presentations into sections with Slide Camp. This is a great
solution for maintaining presentation consistency across 
presentations from your organization. After you set up branding 

oyees will be able to work with predesigned slides to 
easily craft professional presentations. It's geared for larger 
businesses, so if you're a startup or one-person company, this may

for you. 
There are a few plans available, which range from $49 to $499
month depending on the number of users who will access

version as well, so you can try out
 for your business. 
 

While PowerPoint may be a tired way to handle a business
Microsoft has other tools that can introduce a 

new level of practicality to the standard presentation. It recently 
introduced the ability to create live and on-demand events

events can be viewed in real time or on 
workers or even workers who were

the meeting but want to reference what was said. It combines HD 
video with machine learning to create a speaker timeline, speech
text transcriptions and time coding, and closed captioning.

the Office 365 subscription plans.
you're already a subscriber, you can use this tool for no 

when you pay 

provides slide templates for creating company 
presentations. You can adjust color schemes, add company logos, 

 
presentations into sections with Slide Camp. This is a great 

 multiple 
branding 

predesigned slides to 
geared for larger 

company, this may 

which range from $49 to $499 per 
month depending on the number of users who will access Slide 

out the 

way to handle a business 
introduce a 

It recently 
events in 

or on 
workers or even workers who were present in 

combines HD 
timeline, speech-to-

captioning. 
plans. If 



 

additional cost. 
 
7. Powtoon 
Powtoon is an animated presentation and video platform for
creating short informational
brand or product. Explainer videos are an important part of a
brand's message, and Powtoon is an affordable tool for creating
animated videos and presentations to educate consumers and
about your business. You can easily edit presentations
add voiceover, and build a professional experience
customers. 
Powtoon offers a free version,
offerings at $19 and $59 per
8. Video Scribe 
Video Scribe is a whiteboard video presentation platform that
allows small businesses to customize their presentations to fit
needs. These videos, which
"draws" different objects and slides in the presentation, are
for quick explainers and marketing videos on your
product. You can easily place objects, insert text,
your own objects or text with Video Scribe’s
Video Scribe is available for
paid annually, $12 per user per month. If you want to extend
Scribe to a larger team, you'll have to pay $110 to $130
depending on the number of users. You can also make
payment of $665 for a single user.
 
 
9. Prezi 

is an animated presentation and video platform for
informational videos and presentations about

brand or product. Explainer videos are an important part of a
brand's message, and Powtoon is an affordable tool for creating
animated videos and presentations to educate consumers and

siness. You can easily edit presentations and videos, 
add voiceover, and build a professional experience for your

version, but there are more robust 
$59 per month. 

whiteboard video presentation platform that
allows small businesses to customize their presentations to fit

which feature a whiteboard and hand
"draws" different objects and slides in the presentation, are

plainers and marketing videos on your business or 
product. You can easily place objects, insert text, and even draw 
your own objects or text with Video Scribe’s platform. 

available for either $29 per user per month or, if
per user per month. If you want to extend

Scribe to a larger team, you'll have to pay $110 to $130 per user, 
depending on the number of users. You can also make a one

single user. 

is an animated presentation and video platform for 
about your 

brand or product. Explainer videos are an important part of a 
brand's message, and Powtoon is an affordable tool for creating 
animated videos and presentations to educate consumers and clients 

and videos, 
your 

whiteboard video presentation platform that 
allows small businesses to customize their presentations to fit their 

hand that 
"draws" different objects and slides in the presentation, are ideal 

business or 
and even draw 

month or, if 
per user per month. If you want to extend Video 

per user, 
a one-time 



 

Prezi is another template-based presentation solution that you can 
use to create persuasive and engaging presentations with unique 
movement between "slides" and key points. Prezi maps out your 
whole presentation on an overall track that you decide. When you 
switch slides, it doesn't simply advance to the next one; it takes the 
viewer through the track to the point that needs to be made. This 
allows your audience to visualize the progression of your 
presentation. You can arrange content under different sections and 
create an overview so your audience can see your entire 
presentation plan. This method keeps the presentation organized 
and your audience engaged. You can also navigate freely through 
your presentation – your track is not 
locked in and you can adjust when you address which points as 
you're presenting. 
 
Q14 (b) write the steps for the following action for creation of 
power point presentation  Open a blank presentation. Save the presentation as lab1.pptx. Add a title to the first slide the name of your collage. 
Type your first name and last name in the subtitle section. Add a new slide which has a title and content.
 Ans. Opens a blank presentation. 
 Select the File tab to go to backstage view. 
 Select New on the left side of the window, and then 
click Blank Presentation. 
 A new presentation will appear.  
SAVE THE PRESENTATION AS LAB 1. PPTX. 
1. Locate and select the Save command on 
the Quick Access Toolbar. 



 

2. If you're saving the file for the first time, the Save As pane 
will appear in backstage view. 
3. You'll then need to choose where to save the file and give it 
a file name. Click Browse to select a location on your computer. 
Alternatively, you can click One Drive to save the file to your One 
Drive. 
4. The Save As dialog box will appear. Select the location where 
you want to save the presentation. 
5. Enter a file name for the presentation, then click Save. 
6. The presentation will be saved. You can click 
the Save command again to save your changes as you 
modify the presentation. 
You can also access the Save command by pressing Ctrl+S on 
your keyboard. 
Add a title to the first slide the name of your collage. 
 Select the slide whose layout you will change so that it can 
have a title. 
 Click Home > Layout. 
 Select Title Slide for a standalone title page or 
select Title and Content for a slide that contains a title and a full 
slide text box. ... 
 Select the Click to add title text box.  
Add a new slide which has a title and content. 
 
1. Select the slide whose layout you will change so that it can have 
a title. 
2. Click Home > Layout. 
3. Select Title Slide for a standalone title page or select Title and 



 

Content for a slide that contains a title and a full slide text box. 
... 
4. Select the Click to add title text box. 
 
Q15. Write steps for creation of a set of power point slides that 
demonstrates your skills to use the tools of power point. It 
should include the following things. 
 Title slide & bullet list  Inserting excel sheet  Clip art and text 
 Slide show effects 
Ans. Title slide & bullet 
list 
1. Select the slide whose layout you will change so that it can have 
a title. 
2. Click Home > Layout. 
3. Select Title Slide for a standalone title page or select Title and 
Content for a slide that contains a title and a full slide text box. . 
4. Select the Click to add title text box. 
BULLET LIST 
1. On the View tab, click Normal. 
2. Click in the text box or placeholder where you want to add 
bulleted or numbered text. 
3. On the Home tab, in the Paragraph group, click Bullets or 
Numbering. , and begin typing your list. Press Return 
to create a new list item.  
 Inserting excel sheet 
 In PowerPoint, on the Insert tab, click or tap Object. 



 

 In the Insert Object dialog box, select Create from file.
 Click or tap Browse, and in the Browse box, find the Excel 
workbook with the data you want to insert and link to.
 Before you close the Insert Object box, select Link, 
and click OK.  
Clip art and text. 
 Display a slide that contains a Clip Art icon on one 
of its placeholders. ... 
 Click the Clip Art icon to open the Clip Art task pane. 
 In the Search For box, type a word that describes the artwork 
you want; then click the Go button. ... 
 Click the clip you want. ... 
 (Optional) Move or resize the image as desired.  
TEXT. 
 Select a text placeholder or box.  Type in the text you want. 
SLIDE SHOW EFFECTS: 
1. Start by opening a "Blank presentation" in PowerPoint. 
... 
2. Select the "Title Slide" option. ... 
3. Type in your title and subtitle. ... 
4. Select a background for the entire presentation. ... 
5. Add new slides. ... 
6. Set the transitions for your slides. ... 
7. Add some more pizzazz to 
your presentation with animation! 



 

Q16. What is the difference between machine language 
and high level language? 
Ans: High-Level Languages 
A high-level language is a programming language that uses English 
and mathematical symbols, like +, -, % and many others, in its 
instructions. When using the term 'programming languages,' most 
people are actually referring to high-level languages. High-level 
languages are the languages most often used by programmers to 
write programs. Examples of high-level languages are C++, 
FORTRAN, Java and Python. 
To get a flavor of what a high-level language actually looks like, 
consider an ATM machine where someone wants to make a 
withdrawal of $100. This amount needs to be compared to the 
account balance to make sure there are enough funds. The 
instruction in a high-level computer language would look 
something like this: 
x = 100 
if balance x: 
print 'Insufficient balance' 
else: 
print 'Please take your money' 
This is not exactly how real people communicate, but it is much 
easier to follow than a series of 1s and 0s in binary code. 
There are a number of advantages to high-level languages. The 
first advantage is that high-level languages are much closer to the 
logic of a human language. A high-level language uses a set of 
rules that dictate how words and symbols can be put together 



 

to form a program. Learning a high-level language is not unlike 
learning another human language - you need to learn vocabulary and 
grammar so you can make sentences. To learn a programming 
language, you need to learn commands, syntax and logic, which 
correspond closely to vocabulary and grammar. 
The second advantage is that the code of most high-level languages 
is portable and the same code can run on different hardware. Both 
machine code and assembly languages are hardware specific and 
not portable. This means that the machine code used to run a 
program on one specific computer needs to be modified to run on 
another computer. Portable code in a high- level language can run 
on multiple computer systems without modification. However, 
modifications to code in high-level languages may be necessary 
because of the operating system. 
For example, programs written for Windows typically don't run on 
a Mac. 
A high-level language cannot be understood directly by a 
computer, and it needs to be translated into machine code. There are 
two ways to do this, and they are related to how the program is 
executed: a high-level language can be compiled or interpreted. 
MACHINE LANGUAGE: 
Computer can understand only the language of Digital Electronics. 
Digital Electronics deals with presence and absence of voltages. 
Within the computer there are two logics can play their role? These 
logics are − 
 Positive Logic − Here presence of voltage will be denoted 
by 1 and absence of voltage will be denoted by 0 



 

 Negative Logic −Here presence of voltage will be denoted 
by 0 and absence of voltage will be denoted by 1 
But obviously computer can follow anyone of the logics at a time, 
not both the logics simultaneously. To make the computer 
understand, a program can be written using only 0s and 1s. The data 
can also be specified and represented using only 0s and 1s. Such a 
program is called Machine Language program. Machine language 
was the first in the evolution of computer programming languages. 
Computer directly understands a program written in the machine 
language. So as a result, machine language program does not 
require any translator to convert from one form to another. In fact, 
even to this day, basically computers understand only the 0s and 1s. 
Disadvantages of machine language program − Writing a program 
in machine language has the following drawbacks. 
 It is very tiresome to work with and highly error prone. 
While writing the program, a 1 and 0 can get interchanged due to 
typographical error. But then it is very difficult to locate it for 
correction. So a machine language program is very difficult to 
debug. 
 Just having a look at the program, it is very difficult to 
visualize the function of the program. In fact, it is very difficult to 
make out whether a particular bit sequence is an instruction in the 
program, or a data value, or the output result. As instructions, data, 
output and operands, all are represented using 0s and 1s in machine 
language. 
 Machine language programs are platform and architecture- 
dependent. The same program does not work on another computer 
by a different manufacturer. This is because 



 

machine language is different for different computers. Say the bite 
pattern 11110000 means addition in one architecture but might be 
representing subtraction in architecture as well. 
 To develop a program in machine language, the 
programmer must be highly conversant with the organization and 
architecture of the computer system being used. 
Advantages of machine language program −The only advantages of 
writing in machine language are 
 The Machine language program is executed faster than a 
program written in a high-level language (high-level language is 
discussed a little later). The efficiency of the program solely 
depends on the complexity of the program itself. 
 A translator like compiler or interpreter is not needed and 
so results in a cheaper computer system. 
Q17. Discuss about different data types C programming language. 
Ans. Each variable in C has an associated data type. Each data 
type requires different amounts of memory and has some specific 
operations which can be performed over it. Let us briefly describe 
them one by one: 
Following are the examples of some very common data types 
used in C: 
 char: The most basic data type in C. It stores a single 
character and requires a single byte of memory in almost all 
compilers. 
 Int: As the name suggests, an int variable is used to store an 
integer. 
 Float: It is used to store decimal numbers (numbers with 
floating point value) with single precision. 
 Double: It is used to store decimal numbers (numbers with 
floating point value) with double precision. 



 

Different data types also have different ranges up to which they can 
store numbers. These ranges may vary from compiler to compiler. 
Below is list of ranges along with the memory requirement and 
format specifies on 32 bit gcc compiler. 
   

DATA 
TYPE 

MEM
ORY 
(BYT
ES) 

  
RANGE 

FORMAT 
SPECIFIER 

short int  
2 

 
-32,768 to 32,767 %hd 

unsigned 
short int 

 
  
2 

 
  
0 to 65,535 

 
 
%hu 

 unsigned 
 
int 

 
  
4 

  
 
0 to 4,294,967,295 

 
 
%u 

 
 

int 4 
-2,147,483,648 to 
2,147,483,647 %d 



 

DATA 
TYPE 

MEM
ORY 
(BYT
ES) 

  
RANGE 

FORM
AT 
SPECI
FIER 

long int  8  -2,147,483,648 to 
2,147,483,647 

 %
l
d 

unsig
ned 
long 
int 

 
 
 
8 

 
 
 
0 to 4,294,967,295 

 
 
 
%
l
u 

long 
long 
int 

 
  
8 

 
  
-(2^63) to (2^63)-1 

 
  
%
ll
d 

unsi
gned 
long 
long 
int 

 
 
 
  
8 

 
 
 
0 to 
 
18,446,744,073,709,551,615 

 
 
 
  
%
ll
u 



 

signed 
char 

 1  -128 to 127  %c 

unsigned 
 char 

 
 
 1 

 
 
 0 to 255 

 
 
 %c 

 

  
DATA 
TYPE 

MEM
ORY 
(BYT
ES) 

  
RANGE 

FORMAT 
SPECIFIER 

float  4  %f 

double  8  %lf 

long 
double 16  %Lf 



 

 
 
We can use the size of () operatoR to check the size of a variable. See the 
following C program for the usage of the various data types: 
 
 

Q18. Find the output of the following 
expressions. a) X= 20/5*2+30-5    b) Y=30-
(40/10+6)+10 c) Z= 40*2/10-2+10 
Ans.a) X= 20/5*2+30-5=33 (b) Y=30-
(40/10+6)+10=30 c) Z= 40*2/10-2+10=16 
 
 

Q19. Describe the syntax of the following 
statements. 

a) If – else statement (b). for loop (c) while loop 
d) do- while loop 
Ans. A) if – else statement- Syntax 
The syntax of an if...else if...else statement in C programming 
language is − 
if (boolean_expression 1) { 
/* executes when the Boolean expression 1 is true */ 
} else if (boolean_expression 2) { 
/* executes when the Boolean expression 2 is true */ 
} else if (boolean_expression 3) { 
/* executes when the Boolean expression 3 is true */ 
} else { 
/* executes when the none of the above condition is true */ 
} 
 
 
 



 

D) Do loop : // Program to add numbers until the user enters 
zero 

 
#include <stdio.h> 
int main() 
{ 

double number, sum = 0; 

 
 
 
 
 
 
 
 
 
 

 
Q20. Find the output of the followings program segments ? 
a) 
#include<stdio.
h> Int main() 
{ 
int i; 
for(i=1; i<2; i++) 
{ 
Printf(’’IMS Ghaziabad\n’’); 
} 
} 
 
 

// the body of the loop is executed at least once 
do 
{ 

Printf("Enter a number: "); 
scanf("%lf", &number); 
sum += number; 



 

 
A20. a)Output-IMS Ghaziabad 
b) #include<stdi
o.h> int main() 
 
Int i=1; 
while (i<=2 ) 
{ 
Printf(’’IMS Ghaziabad\n’’); 
i=i+1; 
} 
} 
A20.b)Output=IMS 
Ghaziabad IMS Ghaziabad 
 
c) #include<stdi
o.h> void main() 
{ 
int a=10,b=100; 
if(a>b) 
printf(‘’’ Largest number is %d\n’’ ,a); 
else 
printf(“Largest number is %d\n” ‘b); 
} 
A20. C)Output=(“Largest no is b”)  


